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Abstrakt

Sandvik IT Services, en del av Sandvik AB, vill testa och undersoka mojligheten att
fa fram ett alternativ till Microsoft Windows. Hoga licenskostnader kombinerat med
oflexibla avtal for operativsystem och applikationer gor att det finns goda skal att
finna alternativ. Allt fler foretag anvander Linux kostnadsfria program med 6ppen
killkod dd de idag blivit mer attraktivt med stabila, vélutvecklade och
anvandarvénliga distributioner och programvaror. I denna rapport undersoks, testas
och ldggs en grund for fortsatt utveckling av ett kostnadsfritt alternativ, en prototyp
kallad Sandvik Desktop.
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1 Inledning

Nedan féljer en bakgrund, problem, syfte, fragestillningar, avgrdnsningar och
forvantat resultat.

1.1 Bakgrund

Sandvik dr en multinationell hogteknologisk verkstadsindustrikoncern med sin
huvudsakliga verksamhet inom tillverkning och foéradling av olika
metallprodukter. Sandvik grundades 1862 under namnet Sandvikens Jernverks
AB av Goran Fredrik Goransson som forst i vérlden lyckades anvédnda
Bessemermetoden vid stalframstéllning i industriell skala enligt Sandviks
presentation pa deras webbsida[1]. Sandvik fyller darmed 150 ar i ar och firar
det med en stor fest.

Fig. 1: Sandvik

Sandvik finns i 130 ldnder och har globalt ca 50 000 anstdllda med en
omsdttning pa 94 miljarder kronor. Sandvik ar uppdelat i olika affarsomraden:

* Sandvik Mining

* Sandvik Machining Solutions
* Sandvik Materials Technology
* Sandvik Construction

* Sandvik Venture

I Sverige arbetar ca 10 000 varav 5 500 arbetar vid anldggningarna i
Sandviken dar samtliga affarsomraden finns representerade[1].

Sandvik IT Services dr en avdelning som ansvarar for drift, service och
underhall av Sandviks IT-miljoer. Sandvik IT Services finns i 40 lander, bl.a.
USA, Australien, Tyskland, Sydafrika, Kina och Ryssland och har totalt 900
anstdllda varav 500 i Sverige enligt Sandviks IT Services presentation pa
Sandbacka Parks webbsida [2].



1.2 Problem

Pa IT-sidan for Sandvik ligger problemet i hoga licenskostnader och bristen pa
alternativ. Sandvik har hittills bundit upp sig till en enskild leverantors
l6sningar vilket ger ett samre forhandlingsldge ndr avtal ska forldngas.
Standarder vid applikationsutveckling har inte f6ljts da centrala applikationer
enbart fungerar tillsammans med en enskild leverantor, i detta fall Microsoft.

1.3 Syfte

Syftet med arbetet dr att pa grund av hoga licenskostnader skapa ett intresse
och ett bra underlag for en Linuxmiljo pa Sandvik. Idag har Sandvik ett starkt
beroende till Microsofts produkter som ocksa lett till hoga licenskostnader trots
att det finns fullvirdiga lagkostnadsalternativ genom Linux och olika
opensource applikationer.

1.4 Fragestillningar

¢ Ar Linux ett mdjligt alternativ till Microsoft Windows fér Sandvik?

* Vilka fordelar respektive nackdelar finns det fér Linux/Windows for
Sandvik?

1.5 Avgransningar
Arbetet ska begransas till klienter i Sandviken.
1.6 Forvantat resultat

* Att fa fram en vil fungerande produkt och ett bra underlag.
« Att halla en god kontakt med Sandviks affarsomraden.

* Genomfora applikationstester.

* Tester hos affarsomradena.



2 Uppgiftsbeskrivning

* Undersoka mojligheten for en Linux std. Desktop pa Sandvik,
mestadels for att minimera kostnaden for licenser pa Sandvik AB.

* Undersoka vilka program som ar mojliga att kora pa Linux std.
Desktop.

e Jamfora for- och nackdelar mellan Linux- och Windowsklient bade
kostnads-maéssigt och funktionsmaéssigt.

* Tidsatgang for inférandet samt vilka instanser inom Sandvik dér viss
grundutbildning behovs.



3 Teknisk bakgrund

I detta kapitel presenteras olika operativsystem och programvaror som har anvénts for
att ta fram prototypen.

3.1 Operativsystem

En stor del i arbetet &r att jamfoéra operativsystemen och ta fram ett bra
alternativ. Det dr viktigt att operativsystemet motsvarar de tekniska och
sdakerhetsmdssiga krav som stdlls. Operativsystemet ska dessutom vara
attraktivt och anvandarvanligt. Eftersom Microsoft Windows-miljé ar val
inarbetad i malgruppen, sa géller det att hitta en skrivbordsmiljo som kan
efterlikna Windows 7 sa mycket som mojligt men samtidigt inte gora avkall pa
sakerheten och kvalitén.

3.1.1 CentOS

CentOS star for Community ENTerprise Operating System, och &r en
Linuxdistribution baserad pa Red Hat Enterprise Linux. CentOS &r ett mycket
stabilt operativsystem som bl.a. & mycket populért bland webbservrar[3]. En
nackdel med CentOS é&r tidsintervallet mellan versionsuppdateringarna. Andra
Linuxdistrubitioner ligger mer i framkant nér det kommer till utveckling. Vissa
applikationer och tilligg ar heller inte kompatibla med CentOS och andra kan
vara svdra att installera. CentOS kéanns for ovrigt ganska trakigt och &r fran
borjan inte tankt som desktop.

3.1.2 Fedora 16

Fedora é&r ett fritt tillgdngligt operativsystem som till stor del ar utvecklat och
sponsrat av Red Hat, dirav namnet Fedora'. Precis som CentOS och Red Hat r
Fedora RPM-baserat, och anvidnds som en bas for distributionen Red Hat
Enterprise Linux. Fedora &dr en av de mest populdra linuxdistributionerna och
anses vara ett bra alternativ fér nyborjare[4]. Utvecklingen av Fedora ar snabb
och nya utgavor av operativsystemet kommer med jamna mellanrum.

3.1.3 Microsoft Windows 7

Microsoft Windows dr bland persondatorer det mest populédra
operativsystemet. Forsta utgdavan av Windows kom redan 1985 och &r ett val
beprovat operativsystem[5]. Windows distribueras och séljs av Microsoft dar
dven support ingar. Windows ar tillsammans med Office-paketet Microsofts
stora flaggskepp. Manga applikationer utvecklas for, och fungerar val i
Windows. Anvandaren har latt for att kdnna igen sig i en Microsoftmiljo.

3.2 System Management

Systemhanteringsverktygen anvdnds for att distribuera och administrera
klienter till exempel vid uppdateringar, patchar och buggfixar.

'Fotnot: Fedora &r en typ av av hatt av filt som var vanlig under 1950-talet. Al Capone, Indiana
Jones, Michael Jackson och Humphery Bogart dr nagra kdnda bérare av fedorahattar.



3.2.1 Spacewalk

Spacewalk ér en fri programvara for systemhantering som &r utvecklad av Red
Hat[6]. Spacewalk ér ett verktyg som anvdnds for distribution av forinstdllda
operativsystem via en s.k. kickstartfil (Bilaga 8) samt hantering av dessa via ett
webbgranssnitt. Detta dr verktyget som i nuldget kommer att anvdndas vid en
eventuell distribution av Sandvik Desktop.

3.2.2 Red Hat Network Satellite

Red Hat Network Satellite dr systemhanteringsverktyg med webbgranssnitt likt
Spacewalk men for servrar. Det har oppen killkod men supporten kostar
pengar.

3.3 Applikationer
Nedan foljer de applikationer som var aktuella i arbetet.
3.3.1 Lotus Notes

Lotus Notes dr en viktig programvara som har stort anvdndande hos anstéllda
péd Sandvik. Lotus Notes ar utvecklat av IBM och omfattar dokumenthantering,
e-post samt andra webblésningar. Pa Sandvik anvdnds Lotus Notes dven for
motesbokningar, kontaktlistor, chat via Sametime m.m. Det finns dven en
webbaserad version som Sandvik anvidnder[11].

3.3.2 Mozilla Firefox

Mozilla Firefox &r en fri webbldsare som ar baserad pa 6ppen kallkod. Firefox
ar numer mer populdr[17] 4n t.ex. Internet Explorer. Firefox finns till manga
operativsystem och finns tillgangligt pa fler an 70 sprak[10].

3.3.3 LibreOffice

LibreOffice ar ett kostnadsfritt officepaket baserat pa Oppen killkod.
LibreOffice-projektet startades av ”The Document Foundation”, som &r
medlemmar ur tidigare OpenOffice-projektet som blev uppképt av Oracle.
Rédslan for att Oracle skulle infora olika restriktioner resulterade i LibreOffice.
OpenOffice &r resultatet av Sun Microsystems kop av tyska StarDivision.
Huvudskélet till varféor Sun kopte StarDivision 1999 var att pa den tiden
ndrmade sig Sun 42 000 anstallda. I princip alla behévde bade en Unix- och en
Windowslaptop, och det var billigare att kopa ett foretag som kunde
produktivitetsanpassa Solaris- och Linuxdesktops dn det var att kopa 42 000
licenser fran Microsoft[14]. Man valde att ge ut kéllkoden helt och dven ge bort
det gratis som ett alternativ till Microsoft Office med hoga licenskostnader[7].

3.3.3.1 LibreOffice Writer

LibreOffice Writer dr ett ordbehandlingsprogram och motsvarar Microsoft
Word eller Corels WordPerfect och har liknande funktioner. Programmet



stoder de flesta forekommande dokumentformaten saisom ODT, DOC, DOCX,
PDF, HTML, RTF m.fl. [7].

3.3.3.2 LibreOffice Calc

LibreOffice Calc ar ett kalkylprogram och motsvarigheten till Microsoft Excel
eller Lotus 1-2-3 och har liknande funktioner. LibreOffice Calc hanterar bl.a.
filformaten ODF, XLS och CSV samt en rad andra filformat.[7].

3.3.3.3 LibreOffice Impress

LibreOffice Impress ar ett presentationsprogram och motsvarigheten till
Microsoft PowerPoint, men har bl.a. egenskapen att kunna exportera filer till
Adobe Flash-formatet SWF[7].

3.3.3.4 LibreOffice Draw

LibreOffice Draw ér ett program fér att skapa diagram och flodesscheman.
Draw paminner om Microsoft Visio men inkluderar dven mojligheter till
publicering sa som i Scribus och Microsoft Publisher[7].

3.3.3.5 LibreOffice Base

LibreOffice Base éar ett databashanteringsprogram motsvarande Microsoft
Access. Base mojliggor skapande och hantering av databaser, formulédr och
rapporter. Programmet ger &dven stod for olika databassystem sdsom
Accessdatabaser(JET), ODBC datakéllor, MySQL eller PostgreSQL[7].

3.3.4 Project Management

Project Managment, eller Planner som det egentligen heter, & en fri
programvara med oppen kéllkod. Planner motsvarar Microsoft Project och man
kan enkelt skapa gantt-diagram m.m.

3.3.5 GIMP

The GNU Image Manipulation Program, forkortas GIMP, ar ett fritt
bildbehandlingsprogram. GIMP har manga liknande egenskaper som Adobe
Photoshop.

3.3.6 Inkscape

Inkscape ér ett fritt grafiskt verktyg for att skapa och redigera vektorgrafik.
Inkscape kan jamféras med Adobe Illustrator.

3.3.7 Freemind

FreeMind ar ett fritt program som gor det enkelt att skapa sa kallade
tankekartor. Detta kan vara praktiskt nar man jobbar i projekt. En motsvarighet
som anvdnds i Microsoft Windows dr Mindmanager.



3.3.8 Movie Player

Totem Movie Player, som ar det fullstindiga namnet, ar ett fritt
videouppspelningsverktyg.

3.3.9 x3270

x3270 ar en terminalemulator fér IBM's stordatorer som anvands for att ansluta
mot Sandviks IBM-system. Det motsvarar Attachemate Extra!

3.3.10 Shutter

Shutter ar en fri programvara som anvands for att snabbt och effektivt redigera
skdarmdumpar. Det fungerar likvérdigt som SnaglT.

3.3.11 Truecrypt

Truecrypt dr en fri programvara baserad pa dppen kéllkod som anvénds for
kryptering av harddisk. Truecrypt kan koras i Microsoft Windows, Mac OS X
och Linux[12]. Motsvarigheten som idagsldget anvands for laptops pa Sandvik
ar Safeguard.

3.3.12 Spotify

Spotify ar en programvara fér musik. Mjukvaran ar fri men tjansten kan kosta
beroende pa vilken niva av medlemskap man véljer[13]. Detta &r ingen
programvara som anvands av Sandvik men vissa anstdllda anvander det for att
kunna fokusera genom att lyssna pa musik. Spotify installeras i nuldget med
Sandvik Desktop automatiskt.

3.3.13 Cinnamon

Cinnamon &r ett grafiskt anvandargranssnitt som ger Sandvik Desktop ett mer
traditionellt utseende som dterskapar kdnslan av menysystemet som finns i
Windows. Cinnamon &r enkelt att modifiera efter behov och det finns manga
teman att installera. Windowstangenten anvands till att fa fram menyn och det
gar precis som i Windows 7 att skriva programmet som skall startas. Cinnamon
ar en viktig ingrediens i Sandvik Desktop.

3.3.14 System Monitor

System Monitor i Sandvik Desktop dr motsvarigheten till aktivitetshanteraren i
Microsoft Windows. I System Monitor ges en Overblick Over systemet,
processer, resursanvanding samt filsystem.



4 Ekonomisk bakgrund
I detta kapitel presenteras den ekonomiska bakgrunden for arbetet.
4.1 Licenser

Sandvik har globalt drygt 36 500 Microsoftlicenser. Licenskostnaderna ar det
enskilt storsta skalet till varfor det ar viktigt att fa fram alternativa losningar.
Licensavtalen &r relativt komplexa i sin struktur och eftersom Microsoft har
manga produkter och tjanster inbakade i olika paket kan det vara svart att fa en
klar 6verblick 6ver vad som &r vad och vad som gar att bryta ut. Eftersom
avtalen med Microsoft ar foretagshemligheter sd var de ekonomiska siffrorna
inledningsvis svara att fa fram[8].

4.2 Utbildning och support

Kostnaden for att utbilda en person for helpdesk &r inte kdnd utan bara
uppskattad eftersom korrekt information &r svar att finna. Det tar ca 1-2
madnader innan en ny medarbetare i fraga kan jobba utan fadder direkt bredvid
sig och det kan ta mer &n 6 manader innan man ér fullt sjdlvgaende. Daremot,
om det &dr en redan utbildad medarbetare, reduceras inldrningstiden vasentligt
eftersom programvarorna dr i stort sett identiska. Den storsta skillnaden é&r
operativsystemet. I dagsldget arbetar 19 personer pa helpdesk i Sverige och
Sandviken och har ca 4500-5000 drenden per vecka[9]. I ett eventuellt forsta
skede blir inte nyanstdllningar aktuellt men behovet av kvalificerad support
kommer troligtvis oka.

Supporten dr uppdelad i tre lager. First-, second- och third line. First line
ar tidsfokuserat, dar vikten ligger pa snabbhet att svara och slussa vidare mail
och telefonsamtal. Arenden skickas ofta vidare till second line dven om det
kanske gar att 16sa i first line eftersom det ar viktigt att undvika koébildning. De
flesta drenden loser sig i second line och annars gar de vidare till third line. Gar
det mot férmodan inte att 16sas dér sa tillkallas extern support. I Microsofts fall
kallas den externa supporten fér Premier Support[9]. Det dr dock mycket sédllan
supportarenden behover ga sa langt.



5 Metod

Nedan f6ljer de metoder som planeras anvdndas under arbetet.
5.1 Tester

En av huvudmetoderna for att fa fram en bra plattform &r att anvdnda sig av
tester av olika operativsystem och applikationer for att finna det bésta
alternativet for just Sandvik. I testarbetet ingar ocksa att gora jamforelser
mellan olika operativsystem och programvarors styrkor och svagheter.

5.2 Kontakter med nyckelpersoner

En av huvuduppgifterna &r att halla en god kontakt med olika nyckelpersoner.
Det sker huvudsak genom korrespondens via Lotus Notes och personliga
mdten. Moten med personer bokas via Lotus Notes.

5.3 Anvandartester

Anvéandartester av prototypen genomfors av forsokspersoner pa Sandvik IT
Services. For att fa en bra sammanstéllning anvands ett webbaserat formular
med utvalda fragor (Bilaga 5).

5.4 Presentationer

For att fa ut informationen och upplysa om att det finns alternativ till Microsoft
behover det presenteras pa ett bra och enkelt sitt. Detta gors genom moten,
muntlig LibreOffice Impress presentation och foldrar. Efter undersokningar,
studier och tester sammanstéills informationen pa ett ldttbegripligt, attraktivt
och kéarnfullt sétt. Det dr ocksa viktigt att inte ge sken av att det finns en fardig
produkt eller plattform.

5.5 Insamling av information

Nodvandig information samlas in genom mail och samtal med relevanta
personer pa Sandvik IT Services. Information om operativsystem, applikationer
och programmering hdmtas fran olika sajter pa internet.

5.6 Grafiskt granssnitt

Det grafiska granssnittet stravar att efterlikna Windows 7 sa mycket som
mojligt for att anvdndaren ska kdnna sig hemma. Detta ska goéras genom
modifieringar.

5.7 Anvandargrupp

Malgruppen for Sandvik Desktop &r standardanvédndare som é&r i behov av de
vanligaste programvarorna. Inledningsvis personer i Sandviken. Eftersom
Sandvik Desktop inte kan hantera .NET riktar den sig inte i forsta hand till
utvecklare.



6 Genomforande

I detta kapitel presenteras hur genomforandet av arbetet gatt tillvaga.
6.1 Inledning

Inledningsvis handlade det om att skapa en klar overblick av arbetets
omfattning och ta fram lampliga metoder for att kunna 16sa det pa bésta stt.
For en effektiv planering och béttre oversikt av arbetet uppfordes en
projekttavla. Relevanta personer kontaktades och installationer av
operativsystem paborjades.

6.2 Planering

Infér arbetet uppréttades en planeringstavla (Fig. 2) med post-it lappar med
kategorierna: Requests, To Do, In Progress, Done och On Hold. Det
underldttade vasentligt att fa en tydlig 6verblick hur arbetet fortlopte och vad
som stdr i tur att goras och i vilket skede uppgifterna ér i.

REQUESTS| TO DO IN PROGRESS DONE ON HOLD

Fig. 2: Planeringstavla

Inledningsvis var det svart att uppratta en forutbestdimd tidsplanering
eftersom arbetet ej var av sadan karaktir. Ett Gantt-diagram (Fig. 3)
upprattades utifran det som var kédnt i form av planerade moéten, rapporter,
tester och presentationer. Arbetet var beroende av okdnda faktorer som inte
gick att fa in i planeringen, sdsom tidsatgangen pa e-postkonversation och att fa
fram nodvandig information fran Sandvik IT Services. Arbetet fordrojdes en
aning eftersom nodvéndigt material var komplext och av kénslig karaktdr samt
kravde godkdnnande av hégre instans. Méten och oforutsedda handelser gjorde
ocksa att planeringen haltade lite men att halla en linje &r viktigt for att kunna
rapportera eventuella avvikelser.
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Name Work ‘May2012 ‘ i 2012

Week 14 ‘Weekls ‘Weeklﬁ ‘Weem ‘Weekl& ‘Waele ‘Weekm Week 21 ‘Wee<22 ‘Weekn ‘

Planering d

Insamling av information 30d |
Testning av operativsystem 1dd 1

Testning av applikationer 21d \

Presenation for SMC 1d 0

Rapportskrivning 31d \
Librelmoresspresentation 10d

Presentationsfolder )i

Ex:Jobbsavstémaing 1d I
Ekonomisk sammanstallning i L1

Presentation fir Sandvik 1d I

Presentation fir Hogskolan i Gévle |1d 1

Fig. 3: Gantt-diagram
6.3 Prototyping

Eftersom Sandvik IT Services idag dr en Microsoftmiljo dar anvdndarna ar
vana vid Microsoft Windows 7 var det viktigt att fa anvandarna att kénna sig
hemma och eliminera trésklarna.

Inledningsvis hette konceptet Linux Standard Desktop. Ett tidigt beslut
togs att tona ner ordet Linux da det kan avskrdcka den vanliga anvdndaren,
eftersom Linux fortfarande forknippas med kommandotolk och ej sa
anvandarvanligt. Det nya arbetsnamnet doptes till Sandvik Desktop.

En logotyp skapades med konceptet Sandvik Desktop med inspiration
fran Sandvik Coromants logotyp. Typsnittet Helvetica Neue LT Com 55
Roman var identiskt med Sandvik Coromant och beslut togs for att anvdnda det

(Fig. 4).

Nar en logotyp fanns pa plats behovdes en tilltalande standardbakgrund
for att 6ka Sandvikskénslan. Bakgrunden skulle vara bla, stilren med en global
kdnsla och en varldskarta som uppfyllde dessa kriterier. Dérefter placerades
Sandvik Desktop logotypen i det 6vre hogra hornet (Bilaga 6).

Det radde oklarheter vad som gillde kring anvandningen av Sandviks
logotyp i Sandvik Desktop projektet. For att fa klarhet kontaktades Minna
Rodling som dr brandmanager fér Sandvik. Svaret var tydligt, for att &ven om
tanken var god far inte logotypen dndras eller modifieras pa det sétt som gjorts
i fallet Sandvik Desktop. En ny logo skapades med ett stiliserat
tangentbord[18] med texten Sandvik Desktop i typsnittet Helvetica Neue (Fig.
5). Alternativa bakgrunder togs d@ven fram (Bilaga 6).

11



SANDVIK| SANDVIK

Coromant Desktop
Fig. 4: Sandvik Coromant logotyp och prototyp av Sandvik Desktop logotypen

Sandvik Desktop

Fig 5: Slutgilitig logotyp foér Sandvik Desktop

Prototyp av desktopen som togs fram &r designad for att efterlikna
Microsoft Windows 7 eftersom det &r en bekant miljo for de flesta anvédndare.

Inledningsvis testades och CentOS eftersom det &r en stabil och sdker
Linuxdistribution. CentOS &r visserligen bra och anvdndarvédnlig men &r i
grunden inte tdnkt som en desktop utan anvdnds mer till webbserver.
Uppstartsmenyn dndrades ddar CentOS logotypen byttes mot Sandviks. Det
gjordes genom att flytta och dopa om header-image.png genom att anvidnda
kommandon enligt figur 6.

cd /usr/share/plymouth/themes/rings

mv header-image.png header-image.png.orig

mv /home/jshupe/Desktop/logo.png header-image.png

chcon --reference header-image.png.orig header-image.png
mv /boot/initramfs-2.6.32-71.29.1.e16.x86_64.img
/boot/initramfs-2.6.32-71.29.1.e16.x86_64.img.bk

# mkinitrd /boot/initramfs-2.6.32-71.29.1.e16.x86_ 64.img
2.6.32-71.29.1.e16.x86_64

Fig. 6: Kommando for att dindra startlogo

4= S o 3k o

Det sag professionellt och trevligt ut och som ett steg i rétt riktning mot
en stilren Sandvik Desktop. For att efterlikna Microsoft Windows 7 gjordes
flera forsok att installera Cinnamon som ér ett grafiskt plugin for att f& menyer
och kénslan att efterlikna Windows. Menyraden, klocka och kalender placeras
langst ner och fungerar precis som i Microsoft Windows med programanrop
via Start-knappen. Problemet som upptdcktes med CentOS é&r att den inte klarar
av att hantera Cinnamon eftersom det & sd beroende av andra
programbibliotek som dnnu inte dr paketerade och tillgdngliga for CentOS. Det
fanns majligen satt att kringga dven detta med separata bibliotek men var inte
ett alternativ eftersom de kan sluta gélla efter en uppdatering. Eftersom CentOS
inte ar gjort for modifiering i nagon storre utstrackning var operativsystemet
mindre bra for en efterliknelse av Microsoft Windows 7.

Det finns ett antal intressanta Linuxdistributioner som ar skapade som
anvandarvanliga desktops. Ubuntu, Linux Mint och Fedora dr stabila och
beprovade operativsystem som dr ldtta att modifiera med starka
utvecklingsforum bakom. Eftersom Sandvik IT Services anvédnder sig av
systemhanteringsverktyget Spacewalk som dr anpassat for Red Hats
paketeringssystem RPM (Red Hat Pacakge Manager), och Fedora ingar i Red
Hat-familjen foll det sig naturligt att vélja just Fedora. Fedora version 16 &r en
stilren och trevlig desktop som dr létt att konfigurera enligt 6nskemal.
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Eftersom Fedora dr kompatibelt med Cinnamon var det enkelt att installera
och vélja ett tema som liknar Windows 7. Cinnamons utseende styrs av
Cascading Style Sheet (CSS) och det gar att modifiera ett tema genom att géra
andringar i CSS-filen cinnamon.css. Byten av tema gjordes i Cinnamon
Settings och dar valdes temat AnTaRkTiKa. For att fa bredda menyraden och
modifiera fdargerna i menyn konfigurerades CSS-filen med dndringar enligt
figur 7. Se @ven komplett kod enligt bilaga 3.

/usr/share/cinnamon/theme/cinnamon.css

.panel-status-button {
height: 48px;

}
.calendar-month-label {
font-size: 12pt;

}
.datemenu-date-label {

font-size: 15.5pt;
}
.calendar-day-base {
font-size: 12pt;

}

#appMenu {
height: 48px;

}

.system-status-icon {
icon-size: 1.3em;

}
#panel {

height: 48px;
}

Fig 7. CSS stylesheet for Cinnamon.

Systemikoner och kalendern (fig. 8) gjordes storre och veckonummer
lades till. Veckonummer &r nagot som anvands frekvent i Sverige men som inte
finns som standard i Microsoft Windows 7 och dr darmed ett vilkommet tillagg
i Sandvik Desktop.

Wednesday, January 10, 2007

Tuesday May 29, 2012

4 P4 2012 1 January, 2007 L

Su Mo Tu We Th Fr 5a
31 1 Z % 4 5 B
7 8 9fifjnn 12 13
14 15 16 17 18 19 20
21 22 23 M 35 6 27
28 29 30 31 1 2 3
4 5 6 7 8 9 10

6:46:41 PM

Change date and time settings...

Fig. 8: Kalender for Sandvik Desktop och Windows 7
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For att ytterligare forstarka Sandvikskanslan dndrades applikationsmenyn
till sandviksbla och startmenyikonen till ett industriellt kugghjul (fig. 9).

‘ _:;[ Getting Started

All Applications #® Collect Lotus Notes dia d e =
’ Windows Media Center
B8 Accessories M Colect Lotus Notes diagnost S a

==

(@ Evolution Documents

| Calculator
2| KAddressBook
/i Pictures
Kontact ' Sticky Motes

5 KOrganizer 1 ’ s
@ KTmeTracker i % Snipping Tool

3 Games
ibreOffice Calc =
[& Libreoffic w.‘-‘gf Paint

[®) Libreoffice Draw

[ Libreoffice impress %9 Remete Desktop Connectien

LibreOff
a‘- Magnifier
# Lotus s v

F Project Management

Computer
Control Panel

Devices and Printers

% Solitaire
£

% Administration Default Programs

Places
B Plce Help and Support

All Programs

[Shutdown | >

Il as oot e |

G’[Aslar! @ V0B® 9win7default.. B [exjobbrappo...

Fig. 9: Programmeny for Sandvik Desktop och Windows 7

For att fa Sandviksbakgrunden édven i loginsessionen behovdes dndringar
goras i filen verne.xml enligt figur 10. Se dven komplett kod enligt bilaga 2.

verne.xml

<!-- Wide 16:10 -->

<size width="1920" height="1200">/default.png</size>
<!-- Standard 4:3 -->

<size width="2048" height="1536">/default.png</size>
<!-- Normalish 5:4 -->

<size width="1280" height="1024">/default.png</size>

Fig. 10: Utdrag ur verne.xml
6.4 Ekonomisk kalkyl

Eftersom de ekonomiska siffrorna ar foretagshemligheter sa presenteras inte de
i denna rapport. Arbetet med att fa fram licenskostnaderna foregicks av vissa
problem eftersom personen som ansvarade for dessa inte visste om de gick att
lamna ut hur som helst. Efter godkdnnande fran hogre instans kunde siffrorna
lamnas ut och berdkningar kunde pabérjas. Avtalen var otydliga och i viss man
komplexa i sin struktur och behdvde klargéras med e-postkonversation och
ytterligare moten med licensansvarige. Det var manga olika delar i avtalen att
ta hansyn till och hur dessa ska berdknas. Vissa delar var svara att bryta ut i en
kostnad eftersom de ingar i ett storre paket. Efter att ha fatt tillrackligt grepp
om avtalen och kostnaderna sammanstilldes dessa i ett LibreOffice Calc
dokument. Nedan redovisas enbart kostnadsdifferensen i proportion mellan de
olika alternativen.
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Kostnad

SNC Sandvik Desktop

Fig. 11: Ekonomisk kostnadsdifferens mellan nuvarande Sandvik Network
Client (SNC) och Sandvik Desktop.

6.5 Presentation

For att presentera Sandvik Desktop fér olika intressenter behovde det
presenteras pa ett bra och attraktivt satt. For att gora detta skapades en trevlig
vikbar presentationsfolder (Bilaga 1) med bilder och en enkel sammanfattning
om vad konceptet handlar om utan nagra ekonomiska siffror. Foldern &r tankt
att delas ut till ahorare under presentationer fér Sandvik. Innehdllet i foldern
granskades av handledare Per Alm och David Lind innan den trycktes upp i ett
antal exemplar.

Till presentationen skapades ocksa en LibreOffice Impress presentation
(Bilaga 7) som kravde att en speciell Sandviksmall anvédndes. Infér
presentationerna krdvdes forberedelser i form av faktakontroller och
inbjudningar via Lotus Notes.

6.6 Applikationstester

Nedan foljer skriftliga omdomen efter genomférda tester av de aktuella
applikationerna i Sandvik Desktop enligt applikationstabell (Bilaga 4).

6.6.1 Lotus Notes

Lotus Notes fungerar relativt instabilt i bade Microsoft Windows och i Sandvik
Desktop men fungerar nagot stabilare i Sandvik Desktop. Laddningstiderna for
Lotus Notes i Sandvik Desktop dr kortare. Eftersom vissa moduler dr gjorda for
Windows-plattformen sa uppstar det ett felmeddelande som papekar detta nar
Notes kors i Sandvik Desktop. I praktiken dr detta inget att bry sig om for
funktionerna fungerar anda.
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6.6.2 Mozilla Firefox

Vid testning av Mozilla Firefox i jamforelse med Internet Explorer visade det
sig att Firefox dr mindre resurskrdvande. Firefox finns dven for Microsoft
Windows och dven dar upplevs webbldsaren som snabbare. Upplagget foér de
flesta webbldsare dr likartade vilket gor att man latt kdnner sig bekvam med
Firefox ~om  man  tidigare @ bara anvdant Internet  Explorer.
Ett problem med Firefox &r att det inte stoder Active X som dr utvecklat av
Microsoft. Active X anvander Microsofts egna drivrutiner och gér det darfor
omdjligt for andra operativsystem att lata program som kraver Active X att
fungera[15]. Sandvikanstéllda anvander ett webbaserat tidsrapporteringssystem
som heter Projus. Projus bygger pa Active X. Projus &r i behov av en
uppdatering sa forhoppningsvis utvecklas en plattformsoberoende webbtjanst
som fungerar i alla webblasare.

6.6.3 LibreOffice Writer

Vid testning av LibreOffice Writer i jamfoérelse med Microsoft Word framstod
det naturligt att vanan av applikation hade betydelse. Writer &ar en fullvardig
ersattare till Word och det finns mdojlighet till att skrdddarsy ett
ordbehandlingsprogram fér det egna behovet. Denna rapport skrivs helt och
hallet i Writer. Word é&r i nuldget mer utvecklat och beprovat.

6.6.4 LibreOffice Calc

Vid testning av LibreOffice Calc i jamforelse med Microsoft Excel
konstaterades att en vanlig anvandare inte marker nagra storre skillnader. Det
gar utmdrkt att gora avancerade utrdkningar i bada applikationerna. Bada
programmen har likvéardiga funktioner. Utrdkningar samt diagram till denna
rapport samt den enskilda rapporten fér Sandvik har skapats i Calc.

6.6.5 LibreOffice Impress

Vid testning av LibreOffice Impress i jamférelse med Microsoft PowerPoint
framgar det en ganska tydlig skillnad. P4 grund av vana med PowerPoint
upplevs Impress foraldrat. Presentationen av detta examensarbete &dr skapat i
Impress. Nackdelen med Impress ar att det dr en tidskrdvande process att ldra
sig funktionaliteten, &ven om programmet i manga avseenden har likvérdiga
funktioner som PowerPoint.

6.6.6 Project Management

Vid testning av Project Management marktes en tydlighet och enkelhet i
funktionerna som finns. Det &r enkelt att skapa ganttscheman samt 6vriga
diagram. Project Manager anvands till denna rapport.

6.6.7 GIMP

Vid testning av GIMP tycktes det finnas manga funktioner for att skapa
avancerad grafik. GIMP kan jamféras med t.ex. Adobe Photoshop som har
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manga liknande funktioner. For en icke-avancerad anvindare fungerar GIMP
utmarkt.

6.6.8 Shutter

Vid testning av  Shutter uppticktes samma funktionalitet som
Windowsbaserade SnaglIT. Det dr enkelt att ta och redigera screenshots for
olika dandamal.

6.6.9 Cinnamon

Cinnamon heter menysystemet i Sandvik Desktop. Vid testning av Cinnamon i
jamforelse med menyn i Windows 7 finns manga likheter. En bra funktion som
finns i bada menyerna dr snabbknappen, den s.k. Windowsknappen. Den gor
att man far upp menyn direkt och man har dven mojlighet att skriva
programnamnet for att slippa leta och dirav fa en snabbare uppstart. Bada
menyerna har programmen kategoriserade. Likvdrdiga funktioner som
kalender, tid, batteritid m.m. finns ocksa. Cinnamon &r fullt anpassningsbar
vilket gor att man kan forma menyn efter det egna behovet.
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7 Diskussion
Nedan f6ljer en diskussion av resultatet.
7.1 Resultat

Eftersom fragorna som stélldes kunde besvaras ar vi néjda med resultatet. Det
som vi tyvarr inte hann med till denna rapport var att fa fram testresultat fran
anvandartester. Det kan delvis forklaras av att Sandvik IT Services genomgick
en stor omorganisation under perioden som examensarbetet pagick. Vi har tagit
fram ett bra alternativ for fortsatt utveckling och ett underlag fér Sandvik att
arbeta vidare pa. Vi har kunnat visa att det finns stora pengar att spara pa att se
over licenskostnader for operativsystem och programvaror. Arbetet har varit
mycket intressant och utvecklande.

En bra idé for att fa storre acceptans och undvika barnsjukdomar é&r att
anvanda sig av en mjuk 6vergang, genom att stegvis byta ut programvaror t.ex.
att forst borja med att byta ut Microsoft Office till LibreOffice och Internet
Explorer till Mozilla Firefox sa att anvdndarna stegvis vénja sig och utvardera
programvarorna sa att inte forandringen blir for stor pa en gang. D4 finns det
ocksa tid att ratta till eventuella komplikationer och Gvergangen till Open
Source och fri programvara kdnns mer komfortabel. Det sista och naturliga
steget blir sedan att byta hela operativsystemet.

En idé ar ocksa att det redan i grundinstallationen finns bade Microsoft
Windows och Sandvik Desktop installerade, ddr anvandaren i bootmenyn far
vilja vilket operativsystem den vill anvdnda just for tillfallet. Da skapas ett
intresse for Sandvik Desktop och anvdndaren kan i sin egen takt bekanta sig
med alternativet och komma med forslag till justeringar, 6nskemal och
forbattringar.

En annan god idé for att fa genomslag ar att nyckelpersoner och chefer
borjar anvanda Sandvik Desktop och vara goda ambassadorer for alternativet.
Da sprider det sig ldttare och snabbare i organisationen.

Eftersom Sandvik Desktop dr Open Source &r det fullt mojligt att
skraddarsy och modifiera befintliga program sa de passar den egna
organisationen. Da ar det mojligt att tillsdtta ett eget utvecklingsteam som
tillgodoser bade operativsystemet och applikationerna efter de specifika
arbetsuppgifter och krav som Sandvik har.
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8 Slutsatser

Utifran den satta malbilden kan slutresultatet ses som vil genomfért. Den feedback
som givits har varit positiv och gett ett bra underlag for framtida utvecklingar. For att
lyckas med inférandet av ett alternativt operativsystem bor det goéras stegvis.
Inférandet av Sandvik Desktop medfér pa sikt stora besparingar och béttre mojlighet
att anpassa programvarorna till Sandviks verksamhet.

8.1 Utfall

Ar Linux ett méjligt alternativ till Microsoft for Sandvik?

Linux &r klart ett mojligt alternativ for Sandvik. Pa kort sikt handlar det om
mindre arbetsgrupper som idag inte krdver Microsoft programvaror. Pa langre
sikt ndr Microsoftberoendet minskar gar det att utoka anvandandet stegvis. Att
Sandvik skulle bli helt oberoende av Microsoft &r inte troligt och kanske inte
heller 6nskvart eftersom Microsoft och Linux kan komplettera varandra pa ett
bra sdtt. Microsoft har en erkédnt duktig séljorganisation som manga ganger
saljer mer dn vad kunden &r i behov av. Microsoft binder ocksa upp kunderna i
sina egna losningar och programvarorna ar sa beroende av varandra att det kan
vara problematiskt att bryta ut vissa delar. For att infora Sandvik Desktop krédvs
det att applikationsutvecklarna foljer standard och goér programmen
plattformsoberoende. Det krdvs ocksa att Sandvik bryter det totala beroendet
av Microsoft som finns. Att vara sa beroende av en enskild leverantor &r
skadligt, inte bara av ekonomiska skl utan dven utvecklingsmassigt.

Vilka fordelar respektive nackdelar finns det for Linux/Windows for
Sandvik?

Fordelar: Det starkaste argumentet for Linux och open source applikationer ar
forstas de ekonomiska. Det finns stora summor att spara pa licenskostnaderna
och det ger d@ven ekonomiska marginaler att tillsitta egna utvecklare att
skrdddarsy program foér den egna verksamheten. Detta &r fullt mojligt eftersom
det &r 6ppen kallkod. Sdkerheten ér ett annat tungt argument eftersom Linux dr
mycket sdkrare &n Windows da i princip samtliga virus och cyberattacker riktas
mot Windowsklienter [16].

Nackdelar: Eftersom Sandvik idag pa sa médnga plan dr beroende av
Microsofts programvaror och redan investerat mycket pengar i Microsofts
system sd ar det inte mojligt att pa kort sikt fullt ut inféra Sandvik Desktop. Ett
forsta steg ar i sa fall att inféra det pa mindre grupper som exempelvis
stordatorhantering och enklare administrativa sysslor. En del program behover
dessutom testas och anpassas for att battre kunna integreras med Sandviks
nuvarande IT-miljoer. Det behover inte ses som en nackdel eftersom da finns
det mojlighet att béttre anpassa programmen efter de egna behoven. Det &r
ocksd nagot som maste goras for Microsoft. En stor nackdel &r dock att det
fortfarande kravs Microsoft Cal-licenser for att enbart anropa Microsoft AD-
server[19]. Det finns ocksa en rddsla att gd ifran nagot som fungerar.
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Tack

Vi vill ge ett stort tack Sandvik IT Services for att vi fatt dran att genomfora vart
examensarbete hos er. Ett speciellt tack till vara handledare Per Alm och David Lind
for all hjalp, stod och motivation vi fatt under arbetets gdng. Tack ocksa till Kjell
Persson och Carina Jaderberg for den positiva andan och det vanliga bemotandet. Det
har varit en mycket intressant och givande tid och vi hoppas att vart arbete kommer att
ligga till grund for ett nytdnkande i den framtida utvecklingen for Sandvik AB.

Erik Lysén och Mathias Hardin
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BILAGA 1: Informationskompendium for Sandvik Desktop

Open Source

Open Source &r ett
begrepp som vixt sig
starkare pé senare tid
mycket tack vare att
anvandarvénligheten
idag &r s& mycket battre &n fér 10 ar
sedan, Manga foretag ser mijligheten
att spara mycket pengar p& att Gvergd
till Open Source, inte bara av
ekonomiska skal utan ocksa
sikerhetsmissiga.

Open Source produk‘ter utvecklas ocksd
sténdigt genom olika
utveck?arcommunltys utan att
anvandaren behdwver investera eget
kapital. Brister i produkten upptécks
snabbare med manga utvecklare och
atgérdas snabbare. Oberoendet gor
ocks2 att man inte &r bunden till att en
viss leverantdr léser problemet. Open
Source innebar dven att det &r l5ttare
att gora skriddarsydda lésningar som
passar den egna verksamheten.

Stora multinationella féretag som bl.a.
Toyota, Novell, Google, IBM och
Panasonic samt stater och dess
rmyndigheter sdsom amerikanska och
kinesiska post, farsvars- oc
domstolsmyndigheterna anvénder redan
idag Open Source.

Det finns goda skal for Sandvik att ocksa
géra det,

Vad ér Sandvik Desktop?

Sandvik Desktop &r en klient speciellt
framtagen for Sandvik. En
skriddarsydd, saker och stabil klient
som har de mest anvanda
applikationerna och lite till. Den &r
framtagen som ett alternativ till dagens
Windows.

Varfor Sandvik Desktop?

Sandvikkoncernen har idag ca 35.000
klienter som kor pa Microsofts
operativsystem och dess programvaror.
Det innebar mycket higa
licenskostnader samtidigt som det idag
finns det fullvardiga och kostnadsfria
alternativ. Huvudskalet till att anvanda
Sandvik Desktop &r naturligtvis
ekonarmiska men det finns aven en hel
delandra skal till att anvanda Sandwvik
Desktop.

ﬁKostnadseffektlv

Kostnadsfria licenser

+ Kostnadsfria uppdateringar

+  Kostnadsfria mjukwvaror
En stor del av anvindarna har inte

f

nagot behowv av exklusiva
Windowsprodukter

éiAnvéndar\!énlig
Enkelt och valbekant granssnitt
Windowsanvandaren kénner sig
hemma
Latt att anpassa

Screenshots

 Fircfox och Libre Calc

@
‘:@ Sdkerhet

+ Windows &r den primara
malgruppen fiir hackerattacker
Minimalt med virus skapas
avsett far Linux

Systemet tilldterinte virus kéras
utan priviligerade rattigheter.
Systemet ar sakrare | fraga om
atkomst och filrattigheter.
Low/High sakerhet vid
installation

+ De senaste uppdateringarna

Stabil och tidseffektiv
Snabba uppstarter

Stabila appar

Linux dominerar pa
servermarknaden

Erkand stabilitet

@Modern

sSnygg och frasch
Skraddarsydd for Sandvik

= Framtidskansla

+ De senaste uppdateringarna
Open Source

@ Problematik

+ Kompatibilitet
= Uthildning
= Behiver testas och utvecklas

SANDVIK
I

Desktop

Framtidens Plattform

« Kosthadseffektiv

« Saker

« Stabil

« Tidseffektiv
« Modern

* Anvandarvanlig

En presentation av
Mathias Hardin och Erik Lysén
Foldem &r skapad i LibrewWriter

iAppIikationer

De viktigaste applikationerna finns redan
forinstallerade och redo att koras. Lotus
Notes och x3270 &r ofgrandrade men
fungerar stabilare i Sand\.rlk Desktop.
twriga applikationer sdsom
Officepaketet, webblésare och
mediaspelare etc. &r ersatta med vl
fungerande kostnadsfria alternativ.

Sandvik Desktop SNC

117 Lotus Notes Lotus Notes

el Firefox Internet Explorer
N

Libre Writer M5 Word
e

Libre Calc MS Excel

B Libre Impress M5 PowerPoint

i Project Manager M5 Project

s GIMP Adobe Photashop

i Inkscape Adobe ifiustrator
ind

ial Movie Player Windows Media Flayer

= x3270 Attachmate Extra!
@ Shutter SnagiT
Truecrypt Safeguard

& spotify Spotify
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BILAGA 2: Verne.xml

verne.xml

<background>

<starttime>
<year>2011</year>
<month>02</month>
<day>01</day>
<hour>00</hour>
<minute>00</minute>
<second>00</second>

</starttime>

<static>

<duration>10000000000.0</duration>

<file>

<!-- Wide 16:10 -->

<size width="1920" height="1200">/default.png</size>
<!-- Standard 4:3 -->

<size width="2048" height="1536">/default.png</size>
<!-- Normalish 5:4 -->

<size width="1280" height="1024">/default.png</size>
</file>

</static>

</background>
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BILAGA 3: Cinnamon.css

/usr/share/cinnamon/theme/cinnamon.css

.panel-status-button {
height: 48px;

}

.calendar-month-label {
font-size: 12pt;

}

.datemenu-date-label {
font-size: 15.5pt;

¥

.calendar-day-base {
font-size: 12pt;

}

#appMenu {
height: 48px;

}

.system-status-icon {
icon-size: 1.3em;

}
#panel {

height: 48px;
}
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BILAGA 4: Applikationstabell

Sandvik Desktop

SNC

Lotus Notes

Lotus Notes

‘ Firefox Internet Explorer
!
‘ Libre Writer MS Word
\
Libre Calc MS Excel

Libre Impress MS PowerPoint

|

‘ Project Management |MS Project

{
‘ GIMP Adobe Photoshop
\
‘ Inkscape Adobe lllustrator
\

Freemind Mindmanager

‘ Movie Player Windows Media Player

\
x3270 Attachmate Extra!

\

| Shutter SnagIT
Truecrypt Safeguard
Spotify Spotify
System Monitor Task Manager
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BILAGA 5: Webbaserat formular for anvandartester

Anvandartest av Sandvik Desktop

En jamfdrselse mellan Windows 7 och Sandvik Desktop.
Fragorna &r enligt en skala 1-5, dér 3 betyder att det &r likvérdigt.
Dina &sikter &r vardefullal

* Required

Vad tycker du om uppstartstiden? *

1 2 3 4 5

Wycket langsammare & O O O O Mycket snabbare

Vad tycker du om det grafiska utseendet? *
1 2 3 4 5

Mycket samre O O O O O Mycket hattre

Vad tycker du om anvandarvanligheten? *

1 2 3 4 5

Mycket samre O O O O O Mycket hittre

Hur tycker du att Lotus Notes fungerade i Sandvik Desktop? *
1 2 3 4 5

Mycket samre O O O O O Mycket hittre

Vaud tycker du om LibreOffice jamfaort med Microsoft Office?
1 2 3 4 5

Mycket samre O O O O O Mycket hittre

Ar Sandvik Desktop ett tinkbart alternativ for dig? *
1 2 3 4 &

Inte alls tankbart & O O O O Mycket tinkbart

Ar det nagot som du kinner maste firbittras i Sandvik Desktop eller har du nagra andra
synpunkter?

|, ]

Fowered by Google Docs

Report Abuse - Terms of Service - Additional Terms
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BILAGA 6: Sandvik Desktop bakgrunder

SANDVIK
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=] Sandvik Desktop
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BILAGA 7: Sandvik Desktop LibreOffice Impress presentation

Sandvik Deskto

Framtidens plattform

-

SANDVIK
L]
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SANDVIK

Sandvik Desktop

Framtidens plattform

Kostnadseffektiv

Sakerhet

Modern

]

]

# Stabilitet och tidseffektivitet
]

# Anvandarvanlighet

a

Problematik

SANDVIK
L
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Sandvik Desktop

Kostnadseffektiv

# Kostnadsfria licenser
# Kostnadsfria uppdateringar
# Kostnadsfria mjukvaror

# En stor del av anvandarna har inte nagot behov av
exklusiva Windowsprodukter :

™

open source

SANDVIK
L |

Sandvik Desktop
Sékerhet

# 84,8% (mars 2012) av alla klienter kér Windows och ar darmed den
priméra malgruppen for hackerattacker.

# Minimalt med virus skapas avsett for Linux

# Systemet tillater inte virus koras utan priviligerade rattigheter. Systemet
tillter inte virus koras utan priviligerade rattigheter.

@ # Systemet ar sakrare i fraga om atkomst och fikattigheter.
# Low/High sakerhet vid installation

# De senaste uppdateringarna

SANDVIK
L]
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Sandvik Desktop
Stabil och tidseffektiv

# Snabba uppstarter
# Stabila appar
# Linux dominerar pa servermarknaden

# Erkand stabilitet

o

SANDVIK
L |
Sandvik Desktop
Modern
B Snygg och frasch
B Skraddarsydd for Sandvik
B Framtidskansla
B De senaste uppdateringarna
B Open source
SANDVIK
L |
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Sandvik Desktop

Anvandarvanlig

B Enkelt och valbekant granssnitt
B Windowsanvandaren kanner sig hemma

B | it att anpassa

SANDVIK
L |

Sandvik Desktop

Problematik

B Kompabilitet
B Kosthadsfri men kostnad tillkommer
B Behover testas och utvecklas

B Anvandaren maste lara om

SANDVIK
L |
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Sandvik Desktop

Problematik

B Kompabilitet
B Kostnadsfri men kostnad tillkommer

B Behdver testas och utvecklas

SANDVIK
L |

Sandvik Desktop

Alternativa mjukvaror

# Microsoft Office -> Libre Office

Internet Explorer -> Firefox
Adobe Photoshop -> GIMP

Adobe lllistrator -> Inkskape

Lotus Notes -> Lotus Notes

SANDVIK
L |
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Change footer at: View > Slide Master. Select the first slide master and go to Insert > Header & Footer to
change the text. Apply 1o all.

B Change footer at: View > Slide Master. Select the first slide master and go to Insert > Header & Footer to
change the text. Apply to all

35



Change footer at: View > Slide Master. Select the first slide master and go to Insert > Header & Footer to
change the text. Apply to all.
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BILAGA 8: Kickstart Fedora 16

.panel-status-button {
height: 48px;
¥

.calendar-month-label {
font-size: 12pt;
¥

.datemenu-date-label {
font-size: 15.5pt;
¥

.calendar-day-base {
font-size: 12pt;
¥
#appMenu {
height: 48px;
¥

.system-status-icon {

icon-size: 1.3em;
ipanel {

height: 48px;
}# Kickstart file automatically generated by
anaconda.
# Created by Per Alm Sandvik IT Serivces
# Version=DEVEL
install
url --url http://server/distros/fedora-16-x86_ 64/
lang en US.UTF-8
keyboard sv-latinl
network --onboot yes --bootproto dhcp --noipvé
timezone --utc Europe/Stockholm
rootpw --iscrypted
selinux --disabled
authconfig --enableshadow --passalgo=shab512
firewall --service=ssh
clearpart --all --drives=sda
part pv.008003 --grow --size=500
volgroup vg_seduxfedl --pesize=32768 pv.008003
logvol swap --name=lv_swap --vgname=vg_seduxfedl
--grow --size=1008 --maxsize=2016
logvol / --fstype=ext4 --name=lv_root
--vgname=vg_seduxfedl --grow --size=1024
—-maxsize=51200
part /boot --fstype=ext4d --size=500
part biosboot --fstype=biosboot --size=1

bootloader --location=mbr --timeout=5 --append="rhgb

quiet"

xconfig --startxonboot --defaultdesktop Cinnamon
reboot --eject
firstboot --enable
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$packages
@admin-tools

@base

@core
@development-libs
@development-tools
@editors

@fonts
@gnome-desktop
@gnome-software-development
@graphical-internet
@graphics
@hardware-support
@input-methods
@office
@online-docs
@printing
@sound-and-video
@text-internet
@window-managers
@x-software-development
@base-x
kernel-devel

apper

xfsprogs

mtools

gpgme

gpm

brltty

check-devel

lua

check

cmake

leafpad
libreoffice-opensymbol-fonts
pcmanfm
gvis-obexftp
glibmm24-devel
GConf2-devel
libsigc++20-devel
ORBit2-devel
konversation
kdepim
ImageMagick
digikam
kipi-plugins
kdegraphics
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pcsc-lite

gypsy

hdparm

pcsc-lite-ccid

eekboard

iok

kdepim

vorbis-tools

amarok
jack-audio-connection-kit
kdemultimedia-kscd
kdemultimedia-dragonplayer
kdemultimedia-kmix
kdemultimedia-juk

ncftp
matchbox-window-manager
obconf
mesa-1libGLU-devel
xorg-xll-apps
xXscreensaver-gl-extras
Xscreensaver-extras

gdm

xscreensaver-base

Xterm

xorg-xll-resutils

samba

-kong-plugins

%end

FH AR AR AR R AR A AR R A AR AR AR RA R RHA ARSI RE
A ESE RS EEE IR EE S

$post --logfile /root/ks-post-copy.log

wget http://server/pub/RPM-GPG-KEY-fedora-l6-primary
rpm --import RPM-GPG-KEY-fedora-1l6-primary

wget http://server/pub/fedora.repo

wget http://server/pub/fedora-updates.repo

cp -f fedora.repo /etc/yum.repos.d/

cp -f fedora-updates.repo /etc/yum.repos.d/

%end

$post --logfile /root/ks-post-appinst.log
chvt 3
exec < /dev/tty3 > /dev/tty3 2>&l

echo "Installing updates"”
yum update -y

echo "Install extra applications"”
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yum install dkms blueproximity.noarch dconf-editor
x3270.x86 64 x3270-x11.x86 64 tn5250.x86 64 tn5250-
devel.x86 64 -y

echo "Remove Games group"
yum groupremove games -y

echo "Installing Notes Dependencies"

yum install tcsh libart 1gpl 2.s0.2 libasound.so.2
libatk-1.0.s0.0 libbonobo-2.s0.0 libbonobo-
activation.so.4 libbonoboui-2.s0.0 libcrypt.so.l
libc.so.6 libcups.so.2 libdl.so.2 libfontconfig.so.l
libfreetype.so.6 libgcc_s.so.l libgconf-2.so.4
libgdk pixbuf-2.0.s0.0 libgdk-x11-2.0.s0.0 libglib-
2.0.s0.0 libgmodule-2.0.s0.0 libgnome-2.s0.0
libgnomecanvas-2.s0.0 libgnomeprint-2-2.s0.0
libgnomeprintui-2-2.s0.0 libgnomeui-2.so0.0
libgnomevfs-2.s0.0 libgobject-2.0.s0.0 libgthread-
2.0.s0.0 libgtk-x11-2.0.s0.0 1ibICE.so0.6
libjpeg.so0.62 libm.so.6 libnsl.so.l 1libORBit-2.so0.0
libpam misc.so0.0 libpam.so.0 libpango-1.0.s0.0
libpangoft2-1.0.s0.0 libpangox-1.0.s0.0 libpangoxft-
1.0.s0.0 libpngl2.so0.0 libpopt.so.0 libpthread.so.0
libresolv.so.2 librt.so.l 1libSM.so.6 libstdc++.s0.6
libX1l.s0.6 libXcursor.so.l libXext.so.6 libXft.so.2
libXi.so.6 libxkbfile.so.l libxml2.s0.2 libXp.so.6
libXrender.so.l libXss.so.l libXt.so.6 libXtst.so.6
libz.so.1l gnome-desktop -y

echo "Downloading Lotus Notes files"
wget http://server/pub/files/notes-
8.5.3/ibm lotus notes-8.5.3.i586.rpm
wget http://server/pub/files/notes-
8.5.3/ibm lotus sametime-8.5.3.i586.rpm

echo "Installing Lotus Notes 8.5.3"
rpm -Uvh ibm lotus notes-8.5.3.i586.rpm
rpm -Uvh ibm lotus sametime-8.5.3.i586.rpm

echo "Change directory"
cd /opt/ibm/lotus/notes

echo "Get Notes libs"

wget http://server/pub/notes-
8.5.3/notes libs karmic.tgz

tar -zxvf notes libs karmic.tgz

echo "Change rights and owner on files"
chmod +x *.s0.0
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chown root:root *.so0.0
chmod 777 *.so0.0

echo "Install Java"

wget http://server/pub/notes-8.5.3/jre-6u29-linux-
amdé64 .rpm

rpm -ivh jre-6u29-linux-amdé64.rpm

mkdir /usr/libé64/firefox/plugins

cd /usr/lib64/firefox/plugins

ln -s /usr/java/jrel.6.0 29/1ib/amd64/libnpjp2.so
libnpjp2.so

alternatives --install /usr/bin/java java
/usr/java/jrel.6.0 _25/bin/java 20000

alternatives --install /usr/bin/javaws javaws
/usr/java/jrel.6.0 25/bin/javaws 20000
alternatives --install
/usr/lib64/mozilla/plugins/libjavaplugin.so
libjavaplugin.so.x86_64

/usr/java/jrel.6.0 25/1ib/amdé64/libnpjp2.so 20000

echo "Install Adobe flash-plugin 64-bit x86 64"

yum install nspluginwrapper alsa-plugins-pulseaudio
libcurl -y

rpm -ivh http://server/pub/flash/flash-plugin-
11.1.102.55-release.x86_64.rpm

echo "Install Teamview Dependencies"
yum install 1ibXtst.i686 -y

echo "Download & Install Teamview"

wget http://server/pub/teamviewer/teamviewer-7.7.0-
x86 64.rpm

rpm -ivh teamviewer-7.7.0-x86 64.rpm

echo " Install Filezilla"
yum install filezilla -y

echo "Install Shutter (SnagIt clone)"
yum install shutter -y

echo "Install Gnome-RDP & unetbootin (USB Creator

app)"
yum install gnome-rdp unetbootin -y

echo "Install VirtualBox Dependencies"
yum install 1sb -y

echo "Install VirtualBox"
wget http://server/pub/virtualbox/VirtualBox-4.1-
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4.1.12 77245 fedoral6-1.x86_ 64.rpm

rpm -ivh VirtualBox-4.1-4.1.12 77245 fedoralé6-

1.x86 64.rpm

wget
http://server/pub/virtualbox/Oracle VM VirtualBox Ex
tension Pack-4.1.12-77245.vbox-extpack

VBoxManage extpack install

Oracle VM VirtualBox Extension Pack-4.1.12-

77245 .vbox-extpack

echo "Install InkScape (Adobe Illustrator Clone)"
yum install inkscape -y

echo "Install Cinnamon & Theme"

wget http://server/pub/cinnamon/muffin-1.0.2-
1.fcl6.x86_64.rpm

wget http://server/pub/cinnamon/cinnamon-1.4.0-
2.fcl6.x86_64.rpm

rpm -ivh muffin-1.0.2-1.£fcl16.x86_ 64.rpm

rpm -ivh cinnamon-1.4.0-2.fcl16.x86 64.rpm

wget http://server/pub/sandvik/AnTaRtIKkA.tar.gz
tar -zxvf AnTaRtIkA.tar.gz -C
/usr/share/cinnamon/theme/

chmod -Rf 775 /usr/share/cinnamon/theme/

echo "Install Spotify"

wget http://server/pub/spotify/spotify-1.0-

1.x86 64.rpm

rpm -ivh spotify-1.0-1.x86_ 64.rpm --nodeps

rm -f /usr/1ib64/libssl.so0.0.9.8

ln -s /usr/lib/libssl.so.10 /usr/lib/libssl.so0.0.9.8
ln -s /usr/1lib64/1libssl.so0.10
/usr/1ib64/1libssl.s0.0.9.8

ln -s /lib/libecrypto.so.10 /lib/libcrypto.so.0.9.8
In -s /1ib64/libcrypto.so.10
/1ib64/libcrypto.so0.0.9.8

echo "Install sslvpn plugin"

yum install compat-libstdc++-33.i686 -y

wget http://server/pub/snxdeps/snx install.sh
sh snx install.sh

echo "Get & Copy Config Files"

wget http://server/pub/default.png

wget http://server/pub/default.xml

wget http://server/pub/sudoers

wget http://server/pub/verne.xml

wget http://server/pub/Setting-icon.png
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wget http://server/pub/cinnamon.css

wget http://server/pub/layout.js

wget http://server/pub/smb.conf

cp -f default.png /usr/share/backgrounds/

cp -f default.xml /usr/share/backgrounds/
chmod 775 /usr/share/backgrounds/default.*

cp -f default.png /

chmod 775 /default.png

cp -f sudoers /etc/

cp -f verne.xml
/usr/share/backgrounds/verne/default/

cp -f Setting-icon.png /usr/share/cinnamon/theme/
cp -f cinnamon.css /usr/share/cinnamon/theme/
cp -f layout.js /usr/share/cinnamon/js/ui/

cp -f /etc/yum.conf bak /etc/yum.conf

cp -f smb.conf /etc/samba/

clear chvt 1
exec < /dev/ttyl > /dev/ttyl 2>&l
chvt 1

%end
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